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1. Basic concepts of live Excel

What is live Excel?

You use Teamcenter Extensions for Microsoft Office also known as live Excel to do the following:
* Modify Teamcenter objects and properties once you have exported the Teamcenter objects to Excel.
* Make live synchronous updates to Teamcenter objects using Microsoft Excel.

For example, you can use live Excel to modify editable objects and properties for Systems Engineering
requirement structures once you export the requirement structures to live Excel.

To generate a file in live Excel, you export Teamcenter objects to Excel in the Teamcenter rich client using
the interactive, bulk or offline mode options. The options that you select determine the types of changes
you can make in the Excel document and how the changes are updated and committed to Teamcenter.
For example, if you select the Interactive mode option for export, you can modify editable objects and
properties in the Excel document and the changes are dynamically committed to Teamcenter.
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_ 1. Basic concepts of live Excel

Using live Excel is part of a multistep process:
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Note:

To update properties, you must have Teamcenter Extensions for Microsoft Office installed on the
client system, and to make structural changes such as adding or deleting objects you must have
Client for Office installed on the client system.

Offline mode—

1. Create a new Excel object template or use the default template.

You use Excel templates to define how the Teamcenter data is displayed in the Excel file after
import. An Excel template allows you to customize what objects to export and what properties to
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export for an object type. You use rule tables in the Excel template to determine what objects and
properties are exported for a matching rule. Teamcenter provides default templates that you can
use for exporting objects with live Excel.

The following example shows a Systems Engineering requirement structure exported with live
Excel using the REQ_excel_default_template Excel requirement template. The resulting Excel
document displays the requirement elements and properties using the criteria and formatting
defined in the Excel template.
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2. Export Teamcenter objects using live Excel options.
You can work with live Excel spreadsheets that are generated using the following options:

e Interactive mode
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_ 1. Basic concepts of live Excel

* While the Teamcenter rich client is running, the spreadsheet data is synchronized with the
object data in the structure.

* Changes are applied dynamically between the spreadsheet and the structure in both
directions.

¢ Bulk mode

Multiple live Excel edits are committed to Teamcenter at the same time, reducing overhead in
updating a large amount of data.

* Offline mode
* An offline spreadsheet is stored outside of Teamcenter, for example, on a local or shared drive.

* Changes in the spreadsheet are independent of the rich client and are accumulated for later
application to the structure.

Note:

In the Offline mode, adding or deleting objects is not supported by Teamcenter Extensions
for Microsoft Office. To add or delete objects, you must have Client for Office installed on
the client.

3. Make desired changes to Excel document.

The option you select for the export determines the types of changes in the Excel document that
are committed to Teamcenter.

Option selected for export ~ What Excel changes are committed to Teamcenter?

Interactive mode Modified editable objects and properties
Bulk mode Modified editable objects and properties
Offline mode Modified editable objects and properties

New objects by adding rows

Removed objects by deleting rows

Note:

In the Offline mode, to add or delete objects, you must have
Client for Office installed on the client.

4. Commit changes to Teamcenter.
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Exporting Teamcenter data to live Excel _

The option you select for the export determines how the changes in the Excel document are
committed to Teamcenter.

Option selected for export  How are Excel changes committed to Teamcenter?

Interactive mode Automatically committed to Teamcenter
Bulk mode Saving the Excel document in Excel
Offline mode Importing the Excel document to Teamcenter

Exporting Teamcenter data to live Excel

Teamcenter Extensions for Microsoft Office give you synchronous access to Teamcenter objects through
Microsoft Office Excel. Teamcenter live Excel provides direct connectivity from Excel to the Teamcenter
server.

To generate a file in live Excel, you choose the related option when exporting data for selected objects in
the Teamcenter rich client.

* The data exported to the output file consists of property values for the objects.

* The exported property values are synchronized with the corresponding values in Teamcenter.
* Values that you edit in the output file are changed interactively in Teamcenter.

You can export data to live Excel from the following Teamcenter rich client applications.

* My Teamcenter (from the Details view and the navigation pane)

* Multi-Structure Manager

* Structure Manager

* Systems Engineering

Export modes

You can export object data to live Excel in the following output modes:
* Interactive mode

While the Teamcenter rich client is running, the spreadsheet data is synchronized with the object data
in the structure. Changes are applied dynamically between the spreadsheet and the structure in both
directions.
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_ 1. Basic concepts of live Excel

¢ Bulk mode

Multiple live Excel edits are committed to Teamcenter at the same time, reducing overhead in
updating a large amount of data.

e Offline mode

An offline spreadsheet is stored outside of Teamcenter, for example, on a local or shared drive.
Changes in the spreadsheet are independent of the rich client and are accumulated for later
application to the structure.

Working with Teamcenter objects in live Excel

Use Extensions for Office to edit properties of Teamcenter structure objects directly from Microsoft Office
Excel.

The live Excel export file contains a row for each selected object and a column for each specified
property. The file gives you synchronous access to Teamcenter for the following tasks:

* Change property cell values and copy or move values to other cells
When you save your changes, the properties are updated in the database.
* Save exported data locally

You can open local files to start other live Excel sessions, with or without running the Teamcenter
client.

* Navigate to a workspace object from a live Excel file
The object is highlighted in the Teamcenter client.
* Run live Excel reports on Teamcenter objects based on predefined templates that you select

You cab generate live Excel reports provided they are configured by an administrator. You can edit
report cells to change the corresponding property values in Teamcenter without running the rich
client.

You can save reports of the IltemReport type locally, to use them for later live Excel sessions. When
you reopen such a report, you can reconnect it to Teamcenter.
Caution:

Reports of the BOMReport type cannot be reconnected when they are saved locally and
reopened.
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Working with Teamcenter objects in live Excel _

The template determines:
* Which Teamcenter objects are exported to the report.
* Which properties are included for the objects.

Reports cannot be generated from other live Excel files. You must export object data to a new live
Excel file.

Only persistent properties of workspace objects can be changed in Teamcenter. Properties of run-time
objects such as BOM lines cannot be modified from the report.

Note:

Siemens Digital Industries Software recommends that the Teamcenter administrator define
Excel templates to export only workspace objects, such as items and item revisions, and their
persistent properties.
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_ 1. Basic concepts of live Excel
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2. Updating properties with live Excel
dynamically in interactive mode

Edit object properties in Teamcenter while the rich client is running

In interactive mode, live Excel allows you to edit object properties in Teamcenter dynamically, while the
rich client is running.

In interactive mode:
* The spreadsheet data is synchronized with the object data in the corresponding structure.
* Your edits in the spreadsheet are applied to the structure when you choose File->Save in Excel.

* Changes in the structure, made by you or by other users, are reflected automatically when you refresh
the spreadsheet.

You can check out the selected objects from Teamcenter before live Excel generates the output file. If the
selection contains a large number of objects, for example, an entire requirement specification, output
file generation can take a significant amount of time.

Ways to start live Excel in interactive mode

From the Teamcenter rich client, you can start live Excel in interactive mode by doing either of the
following:

* Export object data to a new live Excel output file.
* The data for each exported object occupies a row in the file.
* The file contains a column for each property that you specify.

* Open an existing live Excel file that is stored outside of Teamcenter, for example, on a local or shared
drive.

With this method, an automatic process occurs:

1. The corresponding Teamcenter properties are updated with any changes pending in the live
Excel file.

2. The live Excel data is updated to reflect any changes made in Teamcenter since the file was last
saved.
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_ 2. Updating properties with live Excel dynamically in interactive mode

Start interactive mode from a new output file

1.

Select the export context by doing one of the following:
* To export data for all objects at all levels, select only the peak object.
* To export data for one object at any level, select only that object.
Data is exported also for all direct children and lower level descendants of the selected object.

* To export data for two or more objects, use the standard Windows functions for multiple
selection.

A multiple selection cannot include the peak object. You can select objects at the same level or at
different levels.

Choose Tools—>Export—->Objects To Excel to open the Export To Excel dialog box.
Under Output, select Live integration with Excel (Interactive).

If you select the Check out objects before export check box, you explicitly check out the selected
objects from Teamcenter before the output file is generated. You reserve access to the objects until
you check them in, either when you commit changes to the structure or cancel the changes.

The Check out objects before export check box is cleared by default. You can configure this
option by setting the Show_Checkout_option preference in the Options dialog box.

Under Output Template, do one of the following:
* To export the data in the displayed columns, select Export All Visible Columns.

* To export the data specified in an Excel template, select Use Excel Template to activate the list,
and then select the template.

If the Copy URL button is available, you can click it to place the output file's URL in your Windows
Clipboard. A confirmation message shows the URL details when the output file is generated. The
Copy URL button is unavailable if you select multiple objects or if you select Export All Visible
Columns.

Click OK to generate the output file.

The live Excel file opens with the specified property data for each object in the selected context.
Values that you cannot change in Teamcenter are indicated by comments in the cells.
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Start interactive mode from an existing live Excel file _

Note:

* Excel's hierarchical outlining features are limited to eight levels. For a Teamcenter
hierarchy that is more than eight levels deep, Excel configures the data for all objects
as a flat list in the output file.

* The sort order in the Teamcenter structure does not affect the object sequence in the
output file. Each object is exported according to its position in the structure hierarchy.
In Systems Engineering, an object's Number property determines the row in which that
object is placed in the output file.

Caution:

Do not use Excel's native sorting and filtering features in the output file. The exported objects
and properties must remain aligned with their counterparts in the structure.

Start interactive mode from an existing live Excel file

Caution:

Open an existing live Excel file only if it was exported from My Teamcenter. live Excel features
are not supported for existing files that were exported from a structure editor such as Systems
Engineering, Structure Manager, or Multi-Structure Manager.

1. In My Teamcenter, choose Tools—>Live Excel Open.
An Excel window opens and displays the Open dialog box.
2. Select the file and click Open.

The file opens and the property values are synchronized with the corresponding values in the
structure.

A progress indicator appears during this process, which has two parts:

* First, any live Excel changes made in the disconnected mode are applied to the corresponding
properties in the structure.

» Second, the file is updated with any changes to the structure since the file was last saved.
For some properties, the structure can contain new values that are not reflected in the file.

During this process, other users can edit the same property values for which the file contains
pending changes. These values in the file can be updated again when the process is complete.
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_ 2. Updating properties with live Excel dynamically in interactive mode

Values that you cannot change in Teamcenter are indicated by comments in the cells.
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3. Updating properties with live Excel in
bulk mode

Bulk editing object properties in Teamcenter

In bulk mode, you can save multiple live Excel changes to Teamcenter at the same time. Bulk mode
reduces overhead in communicating with the Teamcenter server, for example, if you intend to edit a
large amount of data.

The bulk mode options are located on the Add-Ins tab on the Excel ribbon.
1. Select the export context by doing one of the following:
* To export data for all objects at all levels, select only the peak object.
* To export data for one object at any level, select only that object.
Data is exported also for all direct children and lower level descendants of the selected object.

* To export data for two or more objects, use the standard Windows functions for multiple
selection.

A multiple selection cannot include the peak object. You can select multiple objects at the same
level or at different levels.

2. Choose Tools—>Export—->Objects To Excel to open the Export To Excel dialog box.
3. Under Output, select Live integration with Excel (Bulk Mode).

If you select the Check out objects before export check box, you explicitly check out the selected
objects from Teamcenter before the output file is generated. You reserve access to the objects until
you check them in, either when you commit changes to the structure or cancel the changes.

The Check out objects before export check box is cleared by default. You can configure this
option by setting the Show_Checkout_option preference in the Options dialog box.

4. Under Output Template, do one of the following:
* To export the data in the displayed columns, select Export All Visible Columns.

* To export the data specified in an Excel template, select Use Excel Template to activate the list,
and then select the template.
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_ 3. Updating properties with live Excel in bulk mode

If the Copy URL button is available, you can click it to place the output file's URL in your Windows
Clipboard. A confirmation message shows the URL details when the output file is generated.

The Copy URL button is unavailable if you select multiple objects or if you select Export All Visible
Columns.

Click OK to generate the output file.

The live Excel file opens with the specified property data for each element in the selected context.
Values that you cannot change in Teamcenter are indicated by comments in the cells.

Note:

* Excel's hierarchical outlining features are limited to eight levels. For a Teamcenter
hierarchy that is more than eight levels deep, Excel configures the data for all objects
as a flat list in the output file.

* The sort order in the Teamcenter structure does not affect the object sequence in the
output file. Each object is exported according to its position in the structure hierarchy.
In Systems Engineering, an object's Number property determines the row in which that
object is placed in the output file.

Caution:

Do not use Excel's native sorting and filtering features in the output file. The exported objects
and properties must remain aligned with their counterparts in the structure.

Edit the cell values in the rows for the objects you want to change.

Caution:

Ensure that each edited value is valid for the property type. An invalid value in any one cell of
a row prevents all updates for that object.

You can undo edits by selecting the cells and clicking Refresh on the Excel Add-Ins tab.
Clicking Refresh restores the previous data in the selected cells.
To commit the changes to Teamcenter, click Save to Teamcenter on the Excel Add-Ins tab.

Before you save changes to Teamcenter, ensure that each edited value is valid for the property type.
An invalid value in any one cell of a row prevents all updates for that object.
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4. Updating properties with live Excel in
offline mode

Editing properties without connecting to Teamcenter

In offline mode, the live Excel spreadsheet is stored outside of Teamcenter.

» After exporting object property data to live Excel, choose File->Save As in the output spreadsheet to
specify its location, for example, on your local desktop or on a shared drive.

* The spreadsheet is not connected to the Teamcenter server but retains its live capability.

Offline mode allows you to use live Excel when you do not have access to the Teamcenter client. For
example:

* On a business flight, you can edit data and accumulate changes in an offline spreadsheet stored on
your laptop computer.

* When you return to your office, you can connect to your Teamcenter server and commit the pending
changes to Teamcenter.

When you open an offline live Excel spreadsheet, you can:

* Remain in offline mode and accumulate further changes pending connection to the Teamcenter
server.

* You can continue to edit property values offline, choosing File=»Save in Excel to accumulate those
changes.

* You connect the spreadsheet to the server to commit the pending changes to the structure.
* Connect to the Teamcenter server and commit pending changes.
After the connection is established, the spreadsheet switches to the interactive mode.
* The spreadsheet data is synchronized with the object properties in the corresponding structure.

* You can apply pending changes in the spreadsheet to the objects in the structure.
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_ 4. Updating properties with live Excel in offline mode

Note:

* Live Excel connects only to the Teamcenter server from which the spreadsheet was
generated.

If that server is unavailable, you cannot switch to another server.
* Direct connectivity is supported only for live Excel spreadsheets that were exported from My
Teamcenter.

A file spreadsheet cannot be connected if it was exported from a structure editor such as
Systems Engineering, Structure Manager, or Multi-Structure Manager.

When you export objects to live Excel, you can check out the objects from Teamcenter before live Excel
generates the output file. Because you check out all of the objects that you select for export, output file
generation can take a significant amount of time if the selection contains a large number of objects, for
example, an entire requirement specification.

Ways to start live Excel in offline mode

You start offline mode by opening an existing live Excel spreadsheet from a location outside of
Teamcenter, for example, from your local desktop or a shared drive. As the spreadsheet opens, live
Excel presents the following options:

* Remain in offline mode and accumulate changes.

Your changes are saved with the offline spreadsheet, pending later connection with the Teamcenter
server.

* Connect to the Teamcenter server and commit pending changes.

Your changes are applied to the objects in the corresponding structure.

Open a live Excel file in offline mode and accumulate changes

1. Open an existing live Excel file from your local file system.
A message asks if you want to connect to the server.

2. Click No to remain disconnected from the server and accumulate changes. Optionally, you can click
Yes to disconnect from the server and accumulate changes.

Note:

Values that you cannot change in the database are indicated by comments in the cells.
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Commit pending changes _

Changes are accumulated and can be applied in Teamcenter by connecting to the server at a later
time.

Commit pending changes
1. Open an existing live Excel file from your local file system.

2. To connect to the Teamcenter server, from the Teamcenter ribbon, click the icon part of the
Import to Teamcenter button.

The Teamcenter Login dialog box is displayed.
3.  Enter your Teamcenter user name and password, and then click Log In.

The values in the worksheet cells are synchronized with the database. A progress indicator appears
during this process, which has two parts:

* First, any pending changes are applied to the database.

The worksheet may contain new values that were entered in disconnected mode. These changes
are now applied to the corresponding properties in the database.

* Second, the worksheet is updated with other changes to the database since the file was last
saved.

For some properties, the database may contain new values that are not reflected in the
worksheet.

Note:

During this process, other users may edit the same property values for which the worksheet
contains pending changes. Therefore, those values also may be updated in the worksheet
when the process is complete.

Values that you cannot change in the database are indicated by comments in the cells.

4-3



_ 4. Updating properties with live Excel in offine mode
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5. Working in live Excel files

Considerations for working in live Excel

Caution:

Do not use Excel's native sorting and filtering features in a live Excel file. The exported objects and
properties must remain aligned with their counterparts in the structure.

The following considerations apply to interactive and offline live Excel sessions:

* Excel's hierarchical outlining features are limited to eight levels. For a Teamcenter hierarchy that is
more than eight levels deep, Excel configures the data for all objects as a flat list in the output file.

* Excel's viewing, printing, and navigation features are available. You can navigate from the file to
objects in the Teamcenter rich client.

* You can send the live Excel output file to e-mail recipients, such as colleagues, customers, and
suppliers. If you save the file, for example, on a local or shared drive, you can attach it to an e-mail
message. Recipients who use the same Teamcenter database can edit the properties also, if those
users have Extensions for Office installed.

* Any live Excel file can be converted to static state as a standard Microsoft Excel file. A static file is
permanently disconnected from the Teamcenter database and cannot be used to edit properties.

* Live Excel does not support Excel's Undo feature. You can undo edits by selecting the cells and
clicking Refresh on the Add-Ins tab.

* Set the TC_allow_modifying_only_checked_out_objects preference to True when you want to
restrict the modification of checked-in objects through Excel Live. This preference applies only to
the objects for which reservation is supported. An error is displayed if you modify objects that are not
checked out. The default value of this preference is False.

* When you export objects to live Excel without checking them out, other users can modify the same
objects after the output file is generated. You can set the TC_setProperties preference to warn of edit
conflicts and to give resolution options when you save your live Excel changes.

* Overwrite another user’s changes and save all of your changes to Teamcenter.

* Discard your changes that conflict with another user’s, and save your non-conflicting changes to
Teamcenter.

* Cancel all changes you made in the output file.
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_ 5. Working in live Excel files

Considerations when using Structure Manager with Live Excel

* In the Structure Manager, if you want to edit a runtime property of a BOM line that will result in
structural modifications such as moving the BOM line within the structure, you must use Excel live in
the Direct Server connectivity mode. If you are using Excel live in the interactive mode, then you must
save the BOM window in the Structure Manager after changing such properties.

* When using Structure Manager, use the bulk live mode. In this mode, after making the required
changes, you must click the Save button to commit the changes to Teamcenter.

* The sort order in the Teamcenter structure in the Structure Manager does not affect the object
sequence in the output file. Each object is exported according to its position in the structure hierarchy.

Considerations when using Systems Engineering with Live Excel

When exporting a structure from Systems Engineering, an object's Number property determines the row
in which that object is placed in the output file.

Changes that do not affect the Teamcenter database

Some changes that you can make in a live Excel file do not affect the database or the Teamcenter
client. For example, inserting or deleting a row in a worksheet does not create or delete an object in
the database. Nor does inserting, deleting, rearranging, or resizing columns in a worksheet change the
property columns displayed in the client.

Excel comment indicators

If Excel's comment indicators are enabled when you select a cell, an indicator marks the cell if it contains
a valid property value for the object. The comment shows the property name and whether the property
is editable. If the property has a choice value, the comment also shows the choices.

Warning:

If a given cell does not contain a comment indicator, that property is not associated with the
object type in the Teamcenter database. Any edits that you make in such a cell are not applied in
the database.

To enable comment indicators:
1. In Excel, open Excel Options.

2. Select Advanced, and then select a comment option under Display.
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view cel commere:

View Excel comments

* To view a comment, rest the pointer on the cell.

* To enable or disable comment indicators, choose Tools—>Options in Excel, and select the related
option on the Preview tab.

Note:

Values that you cannot change are indicated by comments in the cells.

Properties you can edit in live Excel

Live Excel synchronizes Microsoft Office Excel spreadsheets with data in Teamcenter structures. Use live
Excel to edit object property values directly from Excel, in corresponding cells of live spreadsheets.

The following Teamcenter property types are supported by live Excel:

Teamcenter property type Live Excel support
Text Yes
Numeric (integer, float, double) Yes
Date Yes
Single-choice Yes
Multi-choice Yes
LOV Yes
Project-based conditional LOV Yes
Cascading (hierarchical) LOV No'
Note:

Some Teamcenter applications restrict which objects can be modified by means of Live Excel. For
example, some Schedule Manager objects cannot be directly modified outside Schedule Manager.

Change property values in live Excel

1. Double-click the cell in the live Excel file that contains the property value.

1 Cascading LOVs are not supported because Microsoft does not provide a content control for cascading LOV properties.
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Warning:

If the Teamcenter client is running, do not change the value in the client while the cell is in
edit mode. Otherwise, an error message is displayed.

A list appears if the property has a choice value. The choice list can be modified, and you may see
different choices from time to time. If the choice list is a project-based conditional list of values, a
different list of choices may appear for one item than another. This depends on whether the items
are assigned to a project, to which project each item is assigned, and if the applicable projects have
a different list of values for the same property.

A text box opens if the property has a date, numeric, or text value.
Do one of the following:

* In the choice list, select the choice or choices for the new value, and then click another cell to
close the list.

* Buttons indicate a single-choice list using which you can select only one choice.

* Check boxes indicate a multiple-choice list, in which you can specify any combination of
choices. You can select an unchecked choice to add it to the value, or clear a checked choice to
remove it from the value.

* In the text box, enter the new value, and then press the enter key.
* For a date or numeric property, the value must match the valid format for the property.

* For a text property, any keyboard characters are valid, except that the Name property value
cannot contain double quotation marks.

* For a boolean property, in the English locale, you can enter True or False. However, in
nonEnglish locales, enter 0 for False and 1 for True in the Excel.

* Select the cell and enter the new value directly.

Values that you cannot change in Teamcenter are indicated by comments in the cells and such
cells are highlighted in pink.

Tip:

If you create an Excel formula, you can automatically update values in all dependent cells
when you change the value in a precedent cell.

5-4



Resolving edit conflicts _

Note:

In the German locale, a dialog box is displayed in which you can enter multiple values by
specifying a single value in each line. This dialog box is displayed only for double or float
array columns.

Resolving edit conflicts

When you export objects to live Excel without checking them out, other users can modify the same
objects after the export file is generated. Through the TC_setProperties preference, you can be warned
of edit conflicts and given options for resolution.

Depending on the TC_setProperties preference value, the following options can be presented when you
save changes in the export file:

* Overwrite another user’s changes, saving all changes to Teamcenter.
» Discard the changes that conflict with another user’s, saving all other changes to Teamcenter.
* Cancel all changes that you made in the export file.

If you have questions about this feature, consult your Teamcenter administrator.

Copy or move a property cell value
1. Select the source cell, and then choose one of the following:

* To copy the value, choose Edit->Copy.

¢ To move the value, choose Edit—>Cut.

You can select multiple source cells with the standard Windows functions.
2.  Select the destination cell, and then choose Edit—>Paste.

You can select multiple destination cells with the standard Windows functions.

Warning:

Do not copy a single String property value to a multiple selection of cells containing values of
mixed property types, for example, Integer, Date, and Double.

Because of Excel limitations, this action causes the following problems:

5-5



_ 5. Working in live Excel files

* Destination Excel cells receive incorrect values.

» Corresponding values in Teamcenter are corrupted and cannot be modified correctly
thereafter.

Caution:

If you cut the value and paste it into a different row, the value remains with the source object
in Teamcenter and is not moved in the rich client.

Navigate to an object from a live Excel file

To navigate to an object from a live Excel file, the Teamcenter rich client must be installed on

your computer. The rich client must be installed from the same Teamcenter server whose database
contains the object in the Excel file. To support navigation, the WEB_default_site_server and
WEB_default_site_deployed_app_name preferences must be set.

1. In the Home column of the live Excel file, do one of the following:
* Click the GoTo button in the row containing the object.
* Right-click the row containing the object, and then choose GoTo from the shortcut menu.
The Teamcenter rich client Logon window appears.

2.  Enter your user name and password to log on.

The object is displayed and highlighted in the Teamcenter rich client.

Save live Excel changes to Teamcenter

1. Choose File>Exit in Excel.
A message is displayed, asking if you want to save the changes.
2.  Click Yes to display Excel's Save As dialog box.

You can assign the file name, file type, and location.

Warning:

Do not assign the .xlIs or .xlIsx file name extension. Files of these types are permanently
disconnected from the database.
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Convert a live Excel file to static state _

To retain live Excel connectivity, assign the .xIsm file name extension. ‘

3. Click Save to close the file.

Depending on the TC_setProperties preference value, the following options can be presented
when the user saves changes in the export file:

* Overwrite another user’s changes, saving all changes to Teamcenter.
* Discard the changes that conflict with another user’s, saving all other changes to Teamcenter.
* Cancel all changes made in the export file.

You can use this file to start a new live Excel session by opening the file in My Teamcenter.

Convert a live Excel file to static state

You can convert a live Excel file to the static state. A static file is permanently disconnected from
Teamcenter and reverts to the standard Excel functions.

Warning:

This procedure cannot be reversed.

1. Click the Non-Live button on the Teamcenter custom toolbar in Excel.

A confirmation message states that the spreadsheet cannot be converted to a live spreadsheet
again, and asks if you want to continue.

2. Click Yes.

The file is permanently disconnected, and the current objects and properties remain in the static
file.
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6. Sharing Excel reports with others

Accessing Excel reports through URLs

When you export Teamcenter object data to Microsoft Office Excel, you can place the export file’s URL in
your Windows Clipboard. You can then paste the URL into an e-mail message, for example, and send the
message to recipients such as your manager or colleagues.

Recipients can access the export file, which can serve as a report on a selected object, by clicking the
URL. If you generate the export file in live Excel, recipients also can modify the data in Teamcenter
directly from the report. It is not necessary for recipients to run the Teamcenter rich client.

You can export the objects from:

My Teamcenter

Multi-Structure Manager

Systems Engineering

Structure Manager

The Details view in any perspective

Access an Excel report through its URL

1. Click the URL. For example, you may receive the URL in an e-mail message from a subordinate or
a colleague. Or, the URL can be inserted in an Office document that is attached to a message or
stored on a shared drive.

The report opens in a new Excel window.
2. (Optional) If the reportis in live Excel mode, you can modify property values in the report.

When you save modifications to the report, the applicable property values are updated in
Teamcenter.

Note:

If single sign-on (SSO) for Teamcenter applications is not configured for your site, you are
prompted to log on to Teamcenter at both steps 1 and 2. If this occurs, enter your user name
and password, and then click Login for both steps 1 and 2.
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Generate an Excel report and its URL

1.  Select the object to export.
Caution:
Do not select multiple objects.
2. Do one of the following to display the Export to Excel dialog box:

* In My Teamcenter, Multi-Structure Manager, Systems Engineering, or Structure Manager, choose
Tools>Export—>Objects to Excel.

* In the Details view, click the Export Objects to Excel button on the toolbar.
The Export to Excel dialog box appears.

Depending on the perspective or view from which you displayed the dialog box, some options may
not appear or may appear in a different order.

3. Inthe Export to Excel dialog box, select the options for the export.

* (Optional) If you open the dialog box from the Details view, under Object Selection, select
Export Selected Objects.

Caution:
Do not select Export All Objects in View.
* Under Output Template:
a. Select Use Excel Template to activate the template list.
b. In the list, select the template that specifies the data that you want to export.
Caution:
Do not select Export All Visible Columns.
* Under Output, select one of the following:

» Static Snapshot generates a standard Excel file, without Teamcenter live Excel capability.
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Accessing requirements content through URLs in Excel export files _

* Live integration with Excel (Interactive) generates a live Excel file from which you can edit
Teamcenter data in real time while the Teamcenter client is running.

* Live integration with Excel (Bulk mode) generates a live Excel file in which you can
accumulate changes and later connect the file to the Teamcenter server, at which time the
changes are applied in Teamcenter.

Caution:
Do not select Work Offline and Import.
4.  Click Copy URL.
The Copy URL button is unavailable if:
* You select more than one object to export.
* You select any of the following dialog box options:
* Export All Objects in View
* Export All Visible Columns

* Work Offline and Import

One or more of these options may not appear, depending on the perspective or view from which
you opened the dialog box.

The export file is generated and the URL Gener at ed message appears, confirming that the URL is
in your Windows Clipboard and showing the URL details.

Accessing requirements content through URLs in Excel export files

The live Excel export file for a requirements structure may include a column with the heading,
BodyTextURL. This column includes the requirements content value for each of the requirement
revisions exported with the structure.

To include the requirements content URL in the live Excel export file, the export template you use when

exporting the requirements structure must include the run-time property, fnd0_body_text_url, on the
SpecElementRevision business object.

* Click the body text link in the live Excel file to access and edit or view the requirement content.

Any updates you make to the requirements content and save to the linked body text file, are also
updated in Teamcenter and appear in the Details view.
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